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Ma tr ic u le  
1. roll, register.  

2. (Mil) regimental number; (Admin) administrative, official or reference number. 
Source : Collins & Robert French-English English-French Dictionary  

 
Matr ic u le s 

Visual documentary register of the history of Studio XX,  
Matricules offers the Canadian public and community at large, an artistic glimpse into our trajectory,  

as well as an overview of our critical reflection and history regarding issues of creation,  
feminism and engagement with technologies of tomorrow's digital society. 

 
 
 
 
 
 

Matricules was made possible through  
Canadian Heritage's Canadian Culture Online initiative.. 

 

 
 



 

 
 

Summary 
 
 
 

1.  Matricules Archiving Guide 
 
- How to Arch ive a Document 
 
 
 
2.  Matricules Digitilization Guide 
 
- How to D ig it ize and Prepare a Document fo r Archiv ing  
 
 
 
3.  Matricules Archiving Policy 
 
- Understand ing  the Mat r icu les Arch iv ing  System 
 
 
 
 
 
 
 
 
 
 
 
 
Note :  No te:  t hi s guide i s a va i lab le i n P DF fo rmat on the Stud io XX and 
Ma tr ic u le s Websi te :  www. stud ioxx .org ,  a s wel l  wi th an ac company ing 
bookle t and an FAQ on the wo rk ing and the deve lopment o f  the s i t e a t :  
www.s tud ioxx .org/ faq  
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1. DOCUMENTS «TO BE PROCESSED» 

New documents that are in the process of being added to the Matricules archive can be placed 
in the «to be processed» file when these new documents cannot be registered or numbered 
immediately. 

Material (Physical) and Digital documents will be processed differently according to their type.  

 

 Material:  
- Place the item in the red box identified by 
« To be identified, to be processed» 

 
 
The material will be stored in this box until we 
are ready to proceed to the next step. 
 

 

 Digital: 
- Identify the file with an appropriate name to 
help locate it in the future. 

- Place the file on the Studio’s local server in 
the Matricule section (not to be confused with 
the UQAM web server). A password is 
required to log on. 

________________________________ 
 
- Proceed to the TO BE PROCESSED file (in 
red). 
 
- Place it in the TO BE IDENTIFIED file (also in 
red). 
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2. ASSIGNING AN ACCESSION NUMBER TO A DOCUMENT 

• Refer to the document Matricules Archiving Policy to understand how an accession 
number is created. 

• Understand the configuration of an accession number. 

• Open the Excel document MatriculesDocumentCatalog.xls  
The file is located in the Matricules section of Studio XX’s server. 

• Enter the required data in the fields/columns according to the established procedures. 

 

 

• For MATERIAL documents; continue to the next step Identifying material with the P-
Touch labeller. 

• For DIGITAL documents:  
- Rename the file with its new accession number. 
- Place the file onto the server – see the section Filling system for documents on the 
Studio’s local server. 

• For a photo gallery, which is a Matricules document, and has its accession number, 
each photograph that is part of a gallery must be renamed with an accession number 
followed by a distinct ID number: (Ex. 2007FOR30406O_201.JPG). An application 
like Renamer (MAC) can be used for batch renaming of files. Leave all the 
photographs on the local server. However 10-15 photographs should be selected 
and optimised for the web (reduced in size and colour corrected) before importing 
them into Drupal. 
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3. IDENTYING MATERIAL WITH THE HELP OF THE P-TOUCH LABELLER 

Be sure to have obtained the accession number 
previously created in Excel. 

Studio XX is equipped with the portable « P-Touch » 
labelling system. This little machine prints self-adhesive 
labels on a laminated tape. 

The P-Touch labeller is kept in a red box with the stored 
material. The box is labelled: 
« TO BE IDENTIFIED, and TO BE PROCESSED»  
 
Before printing: Make sure that the type settings (height 
and spacing) are configured as described in the printed 
user’s guide. The instructions are explained in detail. 

Once this step is completed: 

- Print the accession number 
- Apply the label on the material, ideally on the support 
envelope. 

 

 

 

- Store the document in it’s corresponding archive box (by year). 

 If this material document is to be digitally captured, proceed to The Digitalization Guide for 
Matricules Material. 
  

Once this step is completed go to the section Classification System for Documents on the 
Studio’s local server in order to learn how to archive the digitalized document. 
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MATRICULES DOCUMENT FILING SYSTEM ON THE STUDIO’S LOCAL SERVER 

The system for archiving digital files is explained in the document Matricules Archiving Policy. 
To upload a file on the server: 
 
- Connect onto the Studio’s local server by choosing the MATRICULE section (requires a 
password: _______________________). 
 
- The tree structure is as follows: 
YEAR / CATEGORY CLASSIFICATION (FBR, FES, PUB…) 
 
Here is an example: 

 

- Place the document in the appropriate file. The file name (which is the accession number) 
always starts with the year followed by the category classification (FBR, FES, PUB…) 

 
In the following example: 2005PRM30325O.mp3  
 - Find the file named 2005, then  
 - Choose PRM 
 - Place the file in that location. 
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ADDING A MATRICULES DOCUMENT INTO DRUPAL 

On the Studio XX web site: 
http://www.studioxx.org 

- Open a session in Drupal* 
*First you must have some basic notions of 
how Drupal works. A user name and password 
are required to add or modify the content. 

In the left menu select Create content 
then choose Matricules Document. 

Complete the fields with the same 
information previously entered in the Excel 
document. (documentspreadsheet.xls). 
 

ATTENTION: The LANGUAGE field must 
be left empty, unless there are a translated 
version of the same document (ex: a 
Press release on PDF). In the field 
Description of Content you can specify if 
the event is in English or in French (in the 
case of a press conference or an interview 
etc…). 

Only when this new document will have 
been linked to it’s corresponding 
Matricules Event will a language be 
chosen. 
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• Determine what type of document it is: Audio, Video, Text or Image. Choose the appropriate 
field (the permitted type and extension are indicated just above the field).  
Note: Enter only ONE TYPE of content even if all the fields are available. 
 

 

• Make sure you are connected to the Studio’s local server on the MATRICULES Section. 

• Click on the BROWSE tab to choose the document (file) to import. Retrieve the file (already 
positioned in right place) on the local server in the MATRICULES section. 

• Click the UPLOAD tab to upload the document into Drupal. 
 
Please Note: Importing a QuickTime file (.mov) takes a while. 
Allow approximately 30 minutes for a document of about 150-200MB 
Wait for the upload process to be complete to avoid any loss of media to the document. 
For smaller files (< 20 MB), normally the length of time is not more than 5 minutes. 
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• Source documents (« afférents » documents) : 
A distinction must be made between a Source Document (afférents documents) for a 
Matricules Document and a Source Document (afférents documents)  for a Matricules 
Event. In this case (for a Matricules Document) a source document is the second part of a 
video file. The source document must already be imported into Drupal so that you may 
select it at this point. At the start of the capture process, a small circle located to the right will 
begin to spin; this indicates that Drupal is searching in the database. Choose your Source 
Document (afférent document). 

 

• Click on the Submit tab to confirm, and add the new Matricules Document into the archive. 

 

• Presto! It is added! Now you can link this Matricules Document to its Corresponding Event 
if such is the case. 

Note: This addition is made in the database. However if you perform a search immediately 
after for that Document it might not be located right away. Drupal updates (refreshes) its 
database every 60 minutes +/-. That means that the Document is in effect in the database, 
but the user does not yet have access to the updated data. 
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6. ADDING A MATRICULES EVENT IN DRUPAL 

• In the left menu, go to Create content 

• Choose Matricules Event 

 

• In the Title field, enter the exact official title of the Event to be added. 

• Choose the language in which you wish to import this new Event. 
In general, Studio XX’s productions and activities are bilingual. You will have to enter the 
Event twice, once in English and once in French. 

• Photo Galleries: If a photo gallery exists that corresponds to this Event, enter its accession 
number here. Note: You must first add this gallery as a Matricules Document in Drupal.  
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• Add a thumbnail of the Event. The image that represents the Event will appear on the site as 
such:  

 

• The dimensions of this image are 150 x 150 pixels. 
2 options are now possible to post this image:  
 

Create the thumbnail in any 
photo software application in 
the right format of (150 x 150). 
Optimise it for the web. 

 

The image is then ready to be 
imported into the following field: 

Let Drupal create the thumbnail. In 
this case it is not necessary to use a 
photo software application. All you 
need is to choose an image (of any 
dimension) from the following field: 

 

• Click on BROWSE to retrieve the image to be imported. This can be placed on the desktop 
of your computer, but must also appear in the photo gallery of the Event (as an archive). 

• Click on UPLOAD to upload the image into Drupal 

• New fields to complete will appear: 

 

Alternative Text: Text that 
replaces the image if image does 
not appear. 

Title: Textual description of the 
image when you mouse over it. 
 
«Delete» box to check to remove 
image. 
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• Adding a description of the Event in the field provided for that purpose: 

 
 

• Three options are given for the data input format. 
The choice of data input format is up to the user. 
Some notions of HTML mark-up are essential in order to integrate text according to the 
required formats (bold, italics, hyperlinks etc.). 

• Link the Source Documents to the Event by entering the accession numbers in the field 
designated for that purpose.  
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• Every type of content (audio, video, participants, PDF Press releases and PDF Programs)  

• has a required field to fill in. This content information must already be entered as a 
Matricules Document in Drupal. 

• Once these steps have been completed, you are ready to confirm the addition of this new 
Event. 

• Verify if the selected publication options correspond to what you want. « Placed on the 
homepage» will show an excerpt of the event on the home page. This is ideal for upcoming 
or recent events. 

 

• Click on the Submit tab to confirm and add this new Matricules Event in the archive. 
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7. ADDING A MATRICULES ENTITY IN DRUPAL 

An Entity refers to a person, often an artist or an organisation. 
The biography of the artist or the mandate of an organisation is entered here. 

Enter here miscellaneous information requested on Entity: 

To access this view: 

• In the menu select Create Content, 
located on the left side of the page. 

• Choose Entity.  
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8. MODIFYING A MATRICULES ITEM IN DRUPAL 

To modify an existing item (Document, Event or Entity) in Matricules, follow these steps:  

Open a Drupal* session 
http://www.studioxx.org/ 

Once you have logged in: 

Choose from the Administer 
menu Manage Content. You can 
also go through search. 

Choose the Event to be modified 
by clicking on its title. 

You will be in  «View » mode by 
default. 
 
Choose the « Edit » tab to make 
changes. 

 

The fields will now be unlocked and can be modified. 

Click on the «Submit» tab to confirm the modifications. 

 



 
MATRICULES – STUDIO XX 

DIGITILIZATION GUIDE 

 
By Sara Mandana Tizhouch, April 2008 

 
 
CAPTURE/SEQUENCE SETTINGS IN THE EDITING SOFTWARE: 

 
 
 
1. Launch the software. Connect the camera to the 

       Firewire port of the computer. Go to the Audio/Video  
       Settings located in the Final Cut Pro tab:  
 

  
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

2. In Sequence Presets, select the preset  
       DV NTSC 48 khz (copy) in order to digitalize  
       from a DV source, then double-click on it to  
       open up the dialog box of graph 3.  
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3. Choose the following options: 
    Frame Rate: 720x480 (3:2)     

P.A.R: NTSC - CCIR 601 (+ Anarmophic 16:9  
If the source is Widescreen)     
Field Dominance: None     
Timebase: 29.97 

 
    Do not click on OK right away.     
 
 
 
 
 
 
 
 
4. In Quicktime Video Settings of     

graph 3, click on Advanced to     
open up the following dialog box.     
Make sure that the quality is set to 100%    
(Best) and that the Scan Mode is    
 Progressive.                                                   

     
(You can change the Aspect Ratio to 16:9 
if the source is Widescreen) 

 
   Click on OK. 
 
 
 
 
 
 

 
 

5. Back in the main menu of      
Audio/Video Settings, select the     
tab Capture Presets. Choose the     
preset DV NTSC 48 khz (copy) by  
double-clicking on it. 
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6. Make sure that under Quicktime 

Video Settings, the option Digitizer reads:     
DV Video + Canon DV.    

 
Click on OK. 

 
 
 
 
 
 
 
 
 

 
 
 
  If you instead read [Missing] DV Video,      
 reboot the camera as well as the  
     software to correct this problem.  
 
 
 
 
 

 
7. In Device Control Presets, leave the     
 default setting at FireWire NTSC. 
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    However, if you want to digitalize from an analog  
 source like the Hi8, select the option 
 Non-Controllable Device in order to digitalize.  
    Afterwards, connect the Hi8 camera with the    
    AVC converter.  
 
 
 
 
 
 
 
 
 
 
 

 
 

8. Once done, go to File -> Log & Capture.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

9. Make sure that the presets you just chose are selected in Capture Settings. 
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In order to be able to hear audio during the digitalization, select the option  
Audio under the tab Clip Settings, and then select Preview.  
Make sure that the stereo mode is selected as well (icon of the  
2 intertwined circles below).  
 
 
 
 
 
 
 
 

 
 

10. In the main window, click on Capture Now and then on the Play button of the camera to begin digitalizing. 
 

11. Once the digitalization finished, click on Escape (button in the upper-left corner of the keyboard).      
      The clip will appear in the project window under the name Untitled1. Save the project and rename the    
       sequence with the same name as the project in order to export it later.  
 
 INTRO SETTINGS:   
 
12. Import the studioxx_logo_2 JPEG as well as the one that you have just modified for the intro taken from     
      the PSD template 2lines or 3lines. Double-click on the file studioxx_logo_2 in order to open it up in the   
      Viewer. Once in the Viewer, click on the image and hit the letter “ i ”. Then, punch in the following value:    
      + 400 (+ enter), followed by the letter ”o”.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

13. While selecting the image in the   
      Preview window, drag it underneath unto    
      the timeline. The clip should be 4 seconds    
      long. 
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14. In the project window, select the tab Effects.  
      Under Video Transitions -> Dissolve, choose the Fade In Fade    
      Out Dissolve effect and drag it onto the timeline underneath,  
 at the end of the logo clip. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
15. Select the JPEG that you have modified for the intro (event title, date, etc.),  
      and double-click on the file to open it up in the Viewer.      
      Once in the Viewer, click on the image and hit the letter “ i ”. Then, punch in the following value:    
      + 400 (+ enter), followed by the letter “o”. 
      Afterwards, follow steps #13-14 again, by adding it directly behind the logo clip.  
 
       (You can as well adjust the type of fade that you want by selecting one of the 3 icons in the  
       Viewer (in the center on top), either Beginning, Center or End.) 
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EDITING PROCEDURE: 
 
 
16. Once the 2 clips stuck together back-to-back with the Fade In + Outs, add the Untitled1 clip that you digitalized right 
behind it. Add a Fade In from the Effects menu on the video track at the beginning of the sequence and again another 
one at the end (which lasts at least 3 seconds), as well as on the audio tracks (Effects-> Audio Transitions -> Cross 
Fade - 0db). 
 
17. All along the sequence, pay attention to the audio levels and make sure that they are correct. In average,    

they should read between -18 et -6, but -9 would be ideal.  
        On the other hand, the background noises and room tone should not be as high. 
 

    
 
 
 
 
 
 
 
 
 
 
  
 
 
     By double-clicking on the audio track in the timeline, the Viewer window will open up the image below.  
     Write the number 0 (+ enter) for the Pan, to make sure that the audio track channels are well balanced.  
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18. By listening to the video sequence, if you notice huge differences in the audio levels, hit the letter P (for  
        Pen Tool), and insert keyframes to adjust the levels, by raising or lowering the levels.  
        
       
 
 
 
 
 
 
 
 
 
 
 (You can increase the size of the track preview for even more precision by clicking on the button that the   
         arrow indicates below).  
 
        If at some point the levels get too high, insert keyframes to correct them by placing a first keyframe,   
        followed by a second one that goes down one or two seconds later (therefore lowers them), and then   
        a third keyframe where the levels should normalize again, followed by a last keyframe that brings   
        the levels back to the same as the rest of the sequence: 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

19. Once the editing done and the audio fixed, go all the way to the beginning of the sequence and hit the   
        letter “ i “, then go all the way at the end and hit the letter “ o “. 

 
 
 
 
 
 
 
 
 



 9 

 
 
EXPORT AND COMPRESSION SETTINGS: 
 
 
20. Select the timeline window and go to   
       File -> Export -> Using Quicktime    
       Conversion: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
21. The following dialog box will open up. Name the document and choose a destination to save it to.  
      Click on Options. 
 
 
 
 
 
 
 
 
 
 
 
 

Once the following dialog box appears, click on the Settings button   
in the Video section:  
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22. Choose the following options:  

 
        Compression Type: H.264 
              Frame Rate: 15 fps 
        Key Frames: Automatic 
              Data Rate: Restrict to 465 kbits/sec 
              Optimized for: Streaming 
              (By default if we choose these settings, the quality should stay at High, and Encoding at Best      
              Quality -Multi-Pass). 
 
              Click on OK. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
23. In the main dialog window, click on the button Size in the Video section in order to open up the following  
      window. In Dimensions, choose 320x240 QVGA, and Deinterlace Source Video. Click on OK. 
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24. Back in the main dialog window, choose the Settings for Sound.  
Choose the following options: 
 
Format: AAC 
Channels: Mono 
Rate: 32.000 kHz 
Target Bit Rate: 64 kbps 
 
Click on OK. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
25. Once done, the whole should loOK like this:  
 
Make sure that the option Prepare for Internet 
Streaming is selected.  
 
Click on OK, which will bring you back to the initial 
window of Quicktime Conversion.  
Click on Save. 
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PROCEDURE FOR MODIFYING THE INTRO: 
 
1. If you ever need to change or add a new intro to an already compressed clip, modify the PSD document in    
    Photoshop then save it as a JPEG.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2. Import the new document into Final Cut with the file studioxx_logo_2 and follow the procedure  
    of paragraphs #12 to 15 once again.   
 
 
 
 
 
 
 
 
3. Once done, hit the letter “ i ” at the beginning of the sequence and “ o ” at the end.  

        With the timeline selected, go to File -> Export -> Using Quicktime Conversion to export the intro.   
    Choose the same options for compression than the ones in paragraphs #21 to 25, with the exception of   
     #24 - leave the Sound option unchecked. Click on OK and save the new intro. 
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4. Find the clip you just saved and open it with Quicktime. Do a CMD-A (Control-All) followed by a CMD-C   
    (Control-Copy).  
    Open up the clip you want to add the new intro to. At the very beginning of the clip, do an “ i ” followed   
     by a CMD-V (Control-Paste) in order to insert the intro. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
5. Verify that the insert is well done and save the clip. 
 
DIGITALIZING AUDIO:  
 
1. Launch the sound editing software. Connect the mini-disc player from the player’s headphones output to the 

computer’s mic input with a jack 1/8 cable. For audio cassette players, connect with an RCA cable  the 2 audio 
outputs of the player to the mic input of the computer with a jack 1/8.  

   Click on Record in order to test the audio levels. In the dialog box that appears, the Input should read  
   Built-in Input, and Monitor should read Built-in Output. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 14 

2. Press Play on the player and then go to the System Preferences of the computer (located in the Dock) in the 
Sound section. In Input, make sure that Line In reads Audio line-in port. You should be able to hear what is 
playing out of the player at the same time.  

 
If the volume is too loud or too low, you must adjust the levels in Input Volume, so that in general the levels read 
somewhere between the center of the scale to the top. If it’s too close to the top, the sound  will be distorted.  
You can also adjust the output levels directly on the mini-disc player.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Once set, return to the sound editing software and press the red button (Record) at the bottom of the dialog box 
(table 1) to begin digitalizing.  

 
4. Once the recording finished, hit OK to save.  

Choose the following options:  
    File Type: AIFF 
    Bit Depth: 16-bits 
    Compressor: None  
 



 15 

5. Open up iTunes. Go to Edit -> Preferences -> Advanced.  Make sure that under the Importing tab, Import Using 
is MP3 Encoder and that the Setting is at Good Quality (128 kbps). 

Now import your audio clips.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
6. Select them and go to Advanced (in the menu bar) and choose Convert Selection to MP3. 

Once done, the new clips will appear under the 44.100kHz clips with a new Sample Rate of 128kbps. 
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Matricules Archiving Policy 
Catalogue Headings 

 
 
 

 
 

• There are 3 types of items that can be catalogued: 
 

1. A document 
2. An event 
3. An entity (individual or organisation) 
 

Each category has its distinct database system for cataloguing with a specific heading 
to manage the content. Please refer to the correct section depending on the type of 
item you are cataloguing. 
 

• General guidelines: If you do not know the information, leave the field blank. Do not 
invent or hypothesize information. 

 
 
DOCUMENT FIELDS 
 

* = Mandatory fields 
 

1. * Accession Number: This is the unique identifier number for each document (Please 
see the following document for further clarification). 

 
2. * Recurring Activities: Select from the list (FBR, FES, ADM, etc – see accompanying 

document for item labels). 
 

3. * Medium: Select from the list (audio, audio/visual, paper print, electronic print, etc.) 
 

4. * Support: Select from the list (Mini DV, Mini Disc, VHS tape, PDF, etc.) 
 

5. * Author: Refers to who produced the item. This is not the name of the person 
speaking in the video, etc. but, rather, the name of the person or institution 
responsible for creating the document. Thus, for the majority of documents the Author 
will be ‘Studio XX.’ 

 
6. * Official title: This is exactly what is written on the item; regardless of whether or 

not this is an accurate reflection of the content. No subjective judgments are to be 
made at the cataloguing stage; the title is whatever is written in the normal title space 
on the item. It is, therefore, an Official title and could be something like: “Femmes 
Branchées/Cameraman: Caroline Martel.” 
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7. * Date: Is the date of the creation of the document. This date represents the date the 
video was shot, the date the CD was burned, etc.  In the case of a website, the date 
specified is when the URL was last visited.  NB: The format for the date must always 
be entered as MONTH/DAY/YEAR.  If the date is unknown or partially unknown, or if 
only the year is noted, enter 01/01/YEAR or 01/01/01. 

 
8. Physical description: Other relevant information about the physical aspects of the 

document such as brand, duration, length, size of document, colour, etc. The physical 
description can be written in either French or English. 

 
9. Content description: Description of content - if available.  For instance: the subjects 

recorded in the audio-visual material, the project description, bibliographical 
references for published material.  The content description can be written in either 
French or English. 

 
10. Source documents (documents “afférents): List the accession numbers of all 

reference documents. 
 

11. Archivist’s notes: These are notes made by the cataloguer and/or the archivist. They 
can include any information the cataloguer and/or archivist deems pertinent. Examples 
might include: “This is CD 3 of a 5 CD set”, “The CD appears scratched”, “The audio 
tape is missing its case”, etc.  

 
12. Location: This refers to the number indicated on the box in which the item is stored. 

 
 

EVENTS 
 

1. * Title: Is the title of the event.  If distinct titles exist in both English and French, 
enter both titles. 

 
2. Participants: Lists the names of the participants. 

 
3. Funders: List the names of funders (i.e.: entities or organisations). 

 
4. * Date: The date of the event.  The date of the event must always be formatted 

MONTH/DAY/YEAR. 
 
5. Description A: Description of the event in French– only if available. Usually directly 

copied from grant or website, but can also include pertinent information, such as: the 
affiliation of the participants, information about funders and co-producers, etc. 

 
6. Description B: Description of the event in English– only if available.  
 
7. Archivists notes: Internal notes made by the cataloguer or archivist related to the 

archiving process or data entries such as issues related to clarity of information, items 
or missing information, etc. 

 
8. * Source documents: This field includes the document numbers of any documents that 

relate to the event. 
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Entities 
 
The cataloguing of individuals and organizations involved in the studio’s activities will exist in 
a relational searching process derived from information entered in the fields of descriptions, 
authors and participants. 
 

 
  



 

16/7/08 Matricules Archiving Policy 4 
Translation and revisions May 6th, 2008 

 
 

Document Item Labels 
By Accession Numbers 

 
 

Accession Numbers 
 
All items should be catalogued with an accession number that takes the following form: 
 
Year (4 numbers), Cataloguing tag (3 CAPITAL letters referring to the recurring activities of 
the studio), Function (one number), Unique identifier number (4 random digits, starting with 
0001 and going up), Status (letter). 
Example: 2001FBR70001M 
 
If there is more than one copy of an item, the first label is followed by “- 1”, the second is 
followed by “- 2”, etc. 
 
If unsure of the cataloguing tag, put “---“ instead. 
Example: 2003---0003 
 
Classification categories (Recurring Activities) 
 
FBR = Femmes branches. 

Including Méta Femmes branchées (presentations + workshops). 
 
FES = Festival (Maid in Cyberspace/HTMlles). 
 
EVS = Special events organised by Studio XX. 

Including all types of events presented outside of the series Femmes Branchées, Méta 
Femmes branchées and the Festival. 

 
PRS = Special projects produced by Studio XX. 
 Projects such as research, outreach and productions of Studio XX. 
 
FOR = Training (workshops, master classes, courses). 
 
RES = Solely projects by artists in residence.  
 
COP = Co-productions and co-presentations. 
 Projects, activities, art events for which Studio XX is a facilitator. 
 
PUB = Printed or electronic publications (.dpi). 
 
PRM = Media programming (XX Files). 
 
ADM = Key administrative documents related to the organizational structure of the studio, 
specifically the charter, list of statements of mandates, AGM reports, list of team and board 
members/year, organizational structure, yearly programming and production grants from the 
Canada Council, etc.  
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Function  
 
Each document catalogue item can be identified as performing one of four functions: 
 
Administration:  Administrative documents are both a function and an activity.  They include 
documents that are the back up of administrative documents. 
This is coded as FUNCTION 1. 
 
Factual live recordings:  Includes all documents that record events, aka “documentation”.  
Examples: Video, audio, photographic records of events. 
This is coded as FUNCTION 3. 
 
Accompanying Materials: Any documents/items relating to or about an event including 
artworks, works presented at the studio, publications from events, artist’s statements, and 
bios. 
This is coded as FUNCTION 5. 
 
Promotional Materials:  Posters, flyers, press. 
This is coded as FUNCTION 7. 
 
No specific function: 
Some projects that cannot be categorized according to the four above-mentioned functions 
are primarily listed as an independent activity (the best examples would be dpi and websites 
not related to events or residencies). 
This is coded as FUNCTION 0. 
 
 
Status 
 
Each catalogue item code must indicate whether or not it is an original document, a copy, a 
working document or a printed version.  Some items may have different versions (i.e., 
original, copy, working version), which means they have the same accession number but each 
item would have a different status code.  
 
Status terminology changes when dealing with different media (i.e., Audio-visual documents 
vs. print and digital documents) but for the purposes of the usability of archived information, 
Matricules has simplified the terms accordingly: 
 
O = Original document. An original document is the first recording (for audio visual 
documents), the digital file of a printed poster, the website, etc.  NB: for the purposes of the 
Matricules project, the most pertinent version is the original. 
 
C = Copy (used only for audio visual recording).  Refers to a direct copy of the original 
document.  It is unlikely that the studio would have many copies of audio-visual recordings. 
 
W = Working document.  Refers to elements that are used in the production of a document.  
Ex: The electronic work file for the design of promotional material. 
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P = Electronic version (PDF) or paper version for which there is an original electronic file. 
Example: 
 

• You are cataloguing a poster. 
• Does the poster have an accompanying digital file? 
• If yes, then the digital file is the most pertinent and is therefore labelled as original. 
• If not, then the poster will be the original. 
• If there are associated files/elements that have gone into the production of the digital 

file, then these are working versions. 
• The PDF made during the archiving process of the digital file is the Print version of the 

item. 
 
Each of these versions as well as each item will have its own accession number that will be 
identical to the related documents, except for its status code.  
 
If there is more than one copy of an item, the first label is followed by “- 1”, the second is 
followed by “- 2”, and so on. 
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 Lexicon for Descriptions 
 
 

 
 

When entering the physical description and the content description of an item, language 
should be consistent to guarantee the linked relationships between items. 
 
Physical Description 
 
In addition to listing the colour, size, and type of the item, the most accurate physical 
description will use the following classifications for the medium and the support material: 
 
Medium options: 
Audio 
Audio/Visual 
Electronic Print 
Paper Print 
Electronic File 
Other 
 
Support options: 
Audiocassette  
Binder  
Book  
Brochure  
Catalogue  
CD  
DAT  
Digital Multimedia 
Digital Photograph 
DVD  
Floppy disc  
Hi8  
Invitation  
Journal  
Mini disc  
Mini DV  
PDF  
Photograph 
Poster  
Program  
Report  
Slide  
Travan drive  
VHS  
Zip disc  
Other  
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Recommendations 
 
 

 
 

• Archived Items should be stored by year in both digital storage systems and physical 
storage systems. 

 
• Digital files should be transferred from discs to the server and then to the external 

archive. 
 

• When a file already exists on the server the back-up diskette is unnecessary. 
 

• For promotional print material, it is only important to save approximately 10 copies. 
 

• PDF’s of all possible files should be created and stored on the external hard-drive. 
 

• The external hard-drive archives should be categorically organized according to the 
system described by the accession numbers. 

 
• If possible, do not label CDs or DVDs with a regular pen or with stickers.  Archival 

quality pens should be used for labelling disks if necessary. 
 

• All future CDs, DVDs, Cassettes, Mini DVDs, should be labelled with the following 
information: Title, author, date, and event. 
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Other Notes 

 
 

 
 

 




